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CHAPTER 1

Introduction
Welcome to the Flare Top Navigation Tutorial. This tutorial focuses on the various features of the
Top Navigation Advanced project template in Flare.
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The Top Navigation Advanced project template in Flare contains several starter topics and other
files intended for online HTML5 output with top navigation like a modern website, instead of the
more traditional tripane format. It includes several features that you might use in online output, and
the content and files have been designed to maximize single-sourcing capabilities. This template
starts you out with two HTML5 targets and a skin that has responsive output based on the device
width. This means the content display changes automatically depending on the device (browser,
tablet, or mobile phone). You can add other kinds of targets and skins if you like.
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CHAPTER 2

Simple Conversion
In this lesson, we show how you can take an existing Flare project and add a few Top Navigation
pieces to it. When you are finished, the existing project will have a look similar to that which is produced from Flare's Top Navigation Advanced template project. The biggest difference is that we are
not attempting to create an elaborate Home page similar to the one found in the template. Also,
while we are adding a context-sensitive menu, it is not as fancy as the one in the template. Instead
of appearing on the side of topics, it displays at the bottom of each page with a simple design.
If you would like to achieve those fancier end results, see "Advanced Conversion" on page 37.
This chapter discusses the following:
Creating a Project
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Creating a Project
You probably already have a Flare project that you want to convert to Top Navigation output. For the
purposes of this tutorial, we are going to create a Flare project that uses the older Tripane format,
pretending it is your existing project that you want to convert. So before we get to the actual conversion, first complete the following steps to create a project.

CREATE A PROJECT
1. Select File > New Project. The Start New Project Wizard opens.
2. In the Project name field, name your project Legacy.
3. (Optional) In the Project folder field, you can enter a location where you want to save your project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.
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5. Under Factory Templates, expand the Online & Print folder. Select the Tripane and PDF
Advanced template.

6. Click Next.
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7. Click Finish. The project is created and loaded into Flare.
If you were to build and view the HTML5 target in this project right away, it would look something like this:

For more information about using this wizard, see the online Help.
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Reorganizing the TOC
Before you convert your actual project, you should review and complete the preliminary tasks to
make sure your output will work well with the new format. One of these preliminary tasks is the
restructuring of the table of contents (TOC) so that the menu items in the output are not overwhelming. You may find that this task requires more time than any of the other steps when converting your project to Top Navigation, depending on the size of your TOC.
In this lesson, we are going to organize the first level items in the TOC in order to limit the number of
top menus. Otherwise, the menu would wrap around to two rows, and that doesn't look good. In your
own project, you might need to also reorganize levels deeper than the first.
If you are unable to reorganize your TOC, there are alternatives, such as hiding the top menu items.
For details, see the online Help.
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REORGANIZE THE TOC
1. In the Project Organizer, expand the TOCs folder.
2. Double-click OnlineOutput (Master), the name of the TOC we will use for the Top Navigation
output. The TOC opens to the right.

The blue text indicates that the TOC entries are using system variables to keep the labels in
sync with the titles of the topics. However, you can override any of the labels, typing whatever
you want, in which the text will display in black.
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3. In Top Navigation output, it is recommended that you do not include your Home page (i.e.,
startup topic) in the menu. Instead, it is linked to the logo in the header. So click on the Welcome item at the top of the TOC and press Delete on your keyboard.
4. A couple of the items seem a bit long, so let’s rename them. First, click on the item labeled
Heading 1 (Converted to H2 in PDF). Press F2 on your keyboard. Then replace the variable syntax with the word Heading as the new label and press Enter.
Next, click the item named Conditions, Notes and Tables and rename it to More.
If you expand the TOC books, you will see a couple of other labels that are somewhat long.
You can change those to shorter names too.
5. Select the book labeled More and in the local toolbar, click
the TOC. It should now look like this:

6. Click

to move that item to the end of

to save your work.

For more information about TOCs, see the online Help.
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Adding and Editing a Skin
Our Legacy project already has a skin in it, but it is the wrong kind of skin. It is designed for Tripane
output. We need to add one that works for Top Navigation.

ADD AND EDIT A TOP NAVIGATION SKIN
1. In the Project Organizer, right-click the Skins folder, and from the context menu select Add
Skin. The Add File dialog opens.
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2. Select the HTML5 - Top Navigation factory template.

3. In the File Name field at the bottom of the dialog, type TopNav as the name of the skin.
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4. Click Add. The skin is added in the Project Organizer next to the Tripane skin, and it opens to
the right in the HTML5 Skin Editor.

5. Select the Styles tab and expand Logo > Background.
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6. Next to the Image field, click

.

The Insert Image dialog opens.
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7. If your image already exists in the skin, you can select it from the list. If it doesn't (and it probably won't), click
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8. Click OK. Your logo displays in the preview of the HTML Skin Editor.

9. Click

to save your work.

For more information about skins, see the online Help.
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Adding a Menu Skin Component
We now have our main Top Navigation skin. But we also want a context-sensitive menu in the topics. So we will add a Menu skin component to the project.
It actually is not mandatory to add a skin component in order to incorporate a menu. The skin component is simply used to format the menu that you insert. However, it is a good idea to add one
because it will be easier when you want to change its look in the future.

ADD AND EDIT A MENU SKIN COMPONENT
1. In the Project Organizer, right-click the Skins folder, and from the context menu select Add
Skin. The Add File dialog opens.
2. Select the HTML5 Component - Menu factory template.

3. In the File Name field at the bottom of the dialog, type TopNavMenu as the name of the skin
component.
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4. Click Add. The skin component is added in the Project Organizer next to the other skins, and it
opens to the right in the Menu Skin Editor.

You can modify the look of the menu and its individual items in many ways. However, for the
purpose of this lesson, let's say you just keep the plain default look.
For more information about skin components, see the online Help.
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Editing the Target
Now we need to tell Flare to use our new HTML5 Top Navigation skin, instead of the older Tripane
skin.

EDIT THE HTML5 TARGET
1. In the Project Organizer, expand the Targets folder.
2. In this particular project, the target is placed inside a subfolder. So expand Online Output.
3. Double-click HTML5 - Tripane (Primary).

The Target Editor opens to the right.
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NOTE: Since you are converting to Top Navigation output, you can rename this target
if you want. However, it's not mandatory. The target will generate the correct output
regardless of what you name it.
4. Select the Skin tab.
5. In the Skin field, select TopNav, the name of your new Top Navigation skin.

6. Click

to save your work.

For more information about targets, see the online Help.
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Inserting the Menu Proxy
Our main Top Navigation skin is all set. But we still need to tell Flare what it should do with our Menu
skin component, which will create the context-sensitive menus on each topic. We don't want to
insert it into each topic separately; that would be too much work. So we'll insert it into a master
page, which will be used by all of the topics.

INSERT THE MENU PROXY
1. In the Content Explorer, expand Resources > MasterPages.
2. Double-click MasterPage.flmsp.

The master page opens to the right in the XML Editor.
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3. This master page already has a Breadcrumbs proxy (used to show "You are here" links at the
top of topics) and a Topic Body proxy (used to display the topic content). There is also a lot of
content below these proxies, which displays at the bottom of each topic. Let's remove this
content. Right-click the div structure bar to the left of the footer content.
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4. From the context menu, select Delete.

The master page should now look like this, with your cursor on an empty paragraph after the
Topic Body proxy.
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5. Select the Insert ribbon at the top of Flare, and on the far right choose Proxy > Insert Menu
Proxy.

The Menu Proxy dialog opens.
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6. In the Linked TOC or Browse Sequence field, select Project/TOCs/OnlineOutput. We will keep
all of the check boxes selected, as well as the default depth level.
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7. In the Skin File field, select Project/Skins/TopNavMenu.
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8. Click OK. The master page should now look like this:

Notice that the other two proxies are indented a bit more. That's because they are located
within the same <div> tag.

Let's move our Menu proxy inside the same tag.
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9. Right-click the structure bar to the left of the Menu proxy, and from the context menu select
Cut.
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10. Right-click the structure bar to the left of the Topic Body proxy, and from the context menu
select Paste After.

The master page should now look like this:

11. Click

to save your work.

For more information about targets, see the online Help.
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Other Tasks
Because you're working with an existing project, we are going to assume you've already completed
the other necessary steps for tying everything together. This includes the following:
n

Associate Stylesheet A stylesheet can be associated with a project, target, or specific files. In
the project used for this lesson, the stylesheet is set at the project level.

n

Associate Master Page You need to associate your master page with the target. In the project used for this lesson, this task is already completed.

n

Set Startup Topic The topic that you want to open initially in the output needs to be designated in the target. In the project used for this lesson, this task is already completed.

For more information about these tasks, see the online Help.
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Building and Viewing Output
Now let's build the output and see how it looks.

BUILD AND VIEW OUTPUT
1. In the Project Organizer, double-click the HTML5 target to open it.
2. In the local toolbar of the Target Editor, click

.

The Builds window pane opens at the bottom of the Flare interface, and the target begins to
generate.
When the build finishes successfully, the Build Progress and Compile Progress cells turn dark
green.
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3. Double-click the row to open the output in your browser. Click on one of the links at the top of
the output. It should look something like this:
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You might be thinking, It looks good, but I really want the context-sensitive menu to appear on
the side of topics, not below them. Like this:

That is certainly possible, but that type of configuration requires some extra work in your regular stylesheet, skin component, and master page. You will need to create some styles and
apply them to the area where you've inserted the Menu proxy in the master page.
If you follow the steps in the Advanced Conversion lesson, a context-sensitive menu like this is
automatically designed for you. See "Advanced Conversion" on page 37.
NOTE: You also might have noticed that the project we converted has "See Also" links
at the bottom of topics. Because we added a context-sensitive menu, you might find
these concept links to be unnecessary in your own converted project. If so, you can
delete those links from your topics.
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CHAPTER 3

Advanced Conversion
In this lesson, we show you how to incorporate HTML5 Top Navigation into an existing Flare project
by borrowing some files and styles from a Flare Top Navigation project template. We then edit some
of those files so that they are completely integrated into the existing project.
The process takes longer than a simple conversion, but you end up with a project that has some
enhanced designs, such as a full-featured Home page and a formatted context-sensitive menu on
the side of topics.
If instead you would like to convert your project to Top Navigation output using an easier process,
see "Simple Conversion" on page 7.
This chapter discusses the following:
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Creating Projects
You probably already have a Flare project that you want to convert to Top Navigation output. For the
purposes of this tutorial, we are going to create two Flare projects to illustrate how you might convert your project to one that produces Top Navigation output. Here are the projects we will create:
n

Legacy Project We will create a Flare project that uses the older Tripane format, pretending it
is your existing project that you want to convert. In an actual conversion process, you will not
need to perform these steps, because you will just use your existing project.

n

Temp Project We will also create a simple Flare project based on one of the Top Navigation
templates. This will be a temporary project. Its only purpose is that we will use it to import into
the legacy project the files that we need. In an actual conversion process, you will perform
these steps.

CREATE THE LEGACY PROJECT
1. Select File > New Project. The Start New Project Wizard opens.
2. In the Project name field, name your project Legacy.
3. (Optional) In the Project folder field, you can enter a location where you want to save your project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.
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5. Under Factory Templates, expand the Online & Print folder and select the Tripane and PDF
Advanced template.

6. Click Next.
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7. Click Finish. The project is created and loaded into Flare.
If you were to build and view the HTML5 target in this project right away, it would look something like this:
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CREATE THE TEMP PROJECT
1. Open a new session of Flare. This way you can have both projects open at the same time.
2. Select File > New Project. The Start New Project Wizard opens.
3. In the Project name field, name your project Temp.
4. In the Project folder field, use the same folder where your legacy project is located.
5. Click Next.
6. Because Flare's Top Navigation project templates contain some elements that we wanted to
use (e.g., the look and feel of the Home page and the side context-sensitive menus), we will
borrow those pieces and make changes to them in our legacy project. Under Factory Templates, expand the Online folder and select the Top Navigation Advanced template.

7. Click Next.
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8. Click Finish. The project is created and loaded into Flare.
If you were to build and view the HTML5 target in this project right away, it would look something like this:

For more information about using this wizard, see the online Help.
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Reorganizing the TOC
Before you convert your actual project, you should review and complete the preliminary tasks to
make sure your output will work well with the new format. One of these preliminary tasks is the
restructuring of the table of contents (TOC) so that the menu items in the output are not overwhelming. You may find that this task requires more time than any of the other steps when converting your project to Top Navigation, depending on the size of your TOC.
In this lesson, we are going to organize the first level items in the TOC in order to limit the number of
top menus. Otherwise, the menu would wrap around to two rows, and that doesn't look good. In your
own project, you might need to also reorganize levels deeper than the first.
If you are unable to reorganize your TOC, there are alternatives, such as hiding the top menu items.
For details, see the online Help.
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REORGANIZE THE TOC IN THE LEGACY PROJECT
Complete the following steps in the Legacy project.
1. In the Project Organizer, expand the TOCs folder.
2. Double-click OnlineOutput (Master), the name of the TOC we will use for the Top Navigation
output. The TOC opens to the right.

The blue text indicates that the TOC entries are using system variables to keep the labels in
sync with the titles of the topics. However, you can override any of the labels, typing whatever
you want, in which the text will display in black.
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3. In Top Navigation output, it is recommended that you do not include your Home page (i.e.,
startup topic) in the menu. Instead, it is linked to the logo in the header. So click on the Welcome item at the top of the TOC and press Delete on your keyboard.
NOTE: In an actual conversion, after you import the files from the temporary project,
you might delete this topic altogether because it will be replaced by the new Home
topic.
4. A couple of the items seem a bit long, so let’s rename them. First, click on the item labeled
Heading 1 (Converted to H2 in PDF). Press F2 on your keyboard. Then replace the variable syntax with the word Heading as the new label and press Enter.
Next, click the item named Conditions, Notes and Tables and rename it to More.
If you expand the TOC books, you will see a couple of other labels that are somewhat long.
You can change those to shorter names too.
5. Select the book labeled More and in the local toolbar, click
the TOC. It should now look like this:

6. Click

to move that item to the end of

to save your work.

For more information about TOCs, see the online Help.
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Importing Files
You now have two projects—Legacy and Temp (which holds the Top Navigation files). Now we need
to get the appropriate files from one project to the other.

IMPORTANT QUESTIONS
Before we import anything, there are a few questions we must ask ourselves.
n

Question 1 Should we transfer all of the files from Legacy to Temp, or should we transfer the
necessary files from Temp into Legacy? In this tutorial, both projects are relatively small. But in
an actual situation, your legacy project is likely to be much larger than the temporary one. And
because importing fewer files is always easier than importing many of them, we are going to
transfer the few necessary files from the Temp project into the Legacy project.

n

Question 2 How should we transfer the files into the Legacy project? One option is to simply
open the project folders in Windows and manually copy the files from one project to the other.
Another option is to use Flare's interface to import different types of files separately. A third
option is to use Global Project Linking to create an import file in the Legacy project and import
only the files we want all at once. There isn't really a wrong answer, and regardless of the
method, we will likely have to do a little bit of cleanup in the Legacy project. Therefore, we are
going with the third option—Global Project Linking—which seems like the easiest, most streamlined way to do it.

n

Question 3 Which of the files from the Temp project do we want to import? Obviously we want
the Top Navigation skin and its related files that give the Top Navigation project template its
look and feel. We also want to bring the Home page into our Legacy project, including some
images. But we don't need most of the topics and many of the images, as well as most of the
project files. In the steps below, we will indicate each file that we want to import (in an actual
conversion, your list of files might be different).
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IMPORT FILES FROM THE TEMP TO THE LEGACY PROJECT
Complete the following steps in the Legacy project.
1. To bring the desired files into our project, we first need to create a project import file. In the
Project Organizer, right-click the Imports folder, and select Add Flare Project Import File.

The Add File dialog opens.
2. In the File Name field at the bottom of the dialog, enter Import from Temp.
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3. Click Add. The import file is added to the Project Organizer, and the Project Import Editor
opens to the right.

4. Under the Source Project field, click Browse.
5. In the dialog that opens, find and select Temp.flprj.
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6. Click Open. The path to the project file is loaded into the Source Project field in the Project
Import Editor.

7. In the Include Files field, click the down arrow and select All Files (*).
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We actually do not want to import all of the files, but because we are bringing in a variety of
files, this is the quickest and easiest option to use at this point. In a moment, we will limit the
files to import.
8. Click

to save your work.

9. In the local toolbar, click Import.
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The Accept Imported Documents dialog opens. This lists and automatically selects all of the
files in the Temp project that do not already exist in the Legacy project.

Notice that there are some files that Flare has found in both projects. That's due to the fact
that many of Flare's project templates contain similar files. In an actual situation, you probably
won't see many (if any) files that are the same in both your existing project and the temporary
project you are importing from.
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10. Remember, we do not want to import all of the files, but rather only a few of them. So at the
bottom of this dialog, click Clear All to remove all of the check marks.

11. Click the check boxes for the following files:
n

Home.htm This is the only topic file we want to import. It is the unique topic used for the
Home page in the template. We will replace the startup topic in our Legacy project with
this topic.

n

BackgroundImage.png This is the large "hero" background image seen on the Home
page.

n

BasicSteps.png This is one of the circular images used in the slideshow on the Home
page. We wanted to use the same image in the same kind of slideshow, so this was an
easy decision.

n

Facebook-Icon-Green.png This is the small Facebook image seen in the footer of the
Home page.
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n

KeyFeatures.png This is another slideshow image we wanted to use.

n

PDF Cover.png This is the image used for the PDF guides on the Home page. We will
import it for this tutorial, just so there isn't a broken link. But in an actual conversion, you
would probably replace this image with your own.

n

TwitterIcon.png This is the small Twitter image seen in the footer of the Home page.

n

WhatsNew.png This is the third slideshow image we wanted to use.

n

HomePage.flmsp This is the master page that is associated with the Home topic. It contains a unique configuration and references to styles we needed, so we definitely want
this file, even though we already have a master page (which we will no longer use).

n

OtherTopics.flmsp This is a second master page in the Temp project that is used for all of
the topics except the Home page. Again, it has a unique configuration, especially with its
inclusion of a Topic Toolbar proxy and the context-sensitive Menu proxy, which we want
to add to our output.

n

StylesForHomePage.css This is the stylesheet created specifically for use by the Home
page. This is where a lot of the hard work exists to get the Home page to look the way it
does, so it is one of the most important files we want to import. However, we will not
import the other stylesheet in the Temp project because we already have our own
stylesheet for the rest of our topics. However, there is one style in the Temp project's
main stylesheet that we want to use, because it affects the look of the context-sensitive
menu. But because it is just one style, we will import it later into the main stylesheet in
our Legacy project.

n

HomeSearchBar.flskn This is a special skin component that the Temp project uses for
the central search bar on the Home page. It's already designed the way we want, so we
will bring it into our Legacy project.

n

HTML5 - TopNavigation.flskn This is the main HTML5 Top Navigation skin that provides
the look for the top menu and search bar, as well as the side flyout menu when the output
is displayed on smaller devices.

n

SideMenu.flskn This is a special skin component used for the context-sensitive menu
that appears next to each topic when it is opened. It is already modified with the look we
want, so we will import this too.

n

Topic-Tool-Bar.flskn This is a special skin component used for the topic toolbar that
appears above each topic. It is already modified with the look and alignment we want, so
we will choose this file as well.
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WARNING: Use caution when selecting files to import. As mentioned, you likely won't
have many files with the same names in your existing project, but you want to avoid
overwriting any of your files that you want to keep.
12. At the bottom of the dialog, click Accept. The files are imported into the Legacy project. The
imported files are placed in the same locations where they existed in the Temp project, ensuring that any links to and from each other are not broken. This will save us some work.
13. Click the x on the tab of the Project Import Editor to close it.
14. In the Project Organizer, click the Import from Temp file and delete it.
We did this for a few reasons. First, we won't need it anymore. Second, Global Project Linking
creates a link from the files in the source project to those in the child project, so anytime we
try to edit one of these files in our Legacy project, Flare will give us a warning. And third, there
is an option in the Project Import Editor that, if not deselected, will automatically import all of
the files from the Temp project (not just the ones we want) if we begin to generate output.
But we do not plan to use the import file the way you might normally use it for Global Project
Linking, and we are all done with it. So by deleting the file, Flare removed any links between
the Temp and Legacy projects. Therefore, we will not see any warnings when we try to edit a
file, and we will not accidentally import files we don't want.
For more information about Global Project Linking, see the online Help.
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Replacing Content and Links
Now that the borrowed files are in our Legacy project, we can make some adjustments to them.
This means replacing some content and links in the Home topic and the imported master page.

REPLACE CONTENT AND LINKS IN THE HOME TOPIC
Complete the following steps in the Legacy project.
1. In the Content Explorer, double-click the Home.htm topic.
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The topic opens to the right in the XML Editor.

The topic doesn't look much like the output from the Temp project, but it will once we associate the correct stylesheet with it and perform a few other edits.
2. Currently, there is a stylesheet (styles.css) that is set at the project level. This is the
stylesheet that we want to use for most of the topics in the Legacy project. However, we want
the Home.htm topic to use the special stylesheet that we imported from the Temp project. At
the top of Flare, select the Project ribbon, and to the far right-click Project Properties. The Project Properties dialog opens.
3. Select the Defaults tab. Notice the styles.css file selected in the Master Stylesheet field.

CHAPTER 3

56

4. Click Allow local stylesheets.

NOTE: If you are working in a project where you have a master stylesheet set in the
affected target (often the primary target), you need to open that target and allow
local stylesheets on the General tab.
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5. Click OK. The look of the topic changes.

This occurred because the StylesForHomePage.css stylesheet was already linked to the
Home.htm topic. We simply had to allow it to be used since a project-level stylesheet was also
set.
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6. Normally you would replace a lot more of the content in this topic than we are going to
replace in this tutorial. We are going to replace only some of the content and links, just for
demonstration purposes and to make sure there are no errors when we build the output. Let's
start with the top of the topic and work our way down.

SLIDESHOW
a. Near the top of the topic you will see a slideshow. We imported three of the four images,
which we will reuse. In an actual situation, you might have your graphic designer replace
these images with others, or you might delete the slideshow altogether. First, let's redirect the link for the first image, which has the words "Getting Started" after it. Right-click
the image and select Hyperlink Image. (If you do not see this option in the context menu,
try clicking off the image and then right-clicking it again.)

The Insert Hyperlink dialog opens.
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b. In the Link to section, select File in Project. Then expand A_Introduction Topics and click
Headings.htm.

c. Click OK.
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d. To the left of the image, click the Slide 2 structure bar to bring the next image into view.

The image in the next slide displays, with the text "Basic Steps" under it.
e. Use the same steps as above to link this image with the DropDowns.htm topic in the project. We realize that the image doesn't really have anything to do with drop-downs, but
this is just for demonstration purposes to show how to create hyperlinks on images. In
your real project, you would replace this image with one that is more appropriate and/or
you would link it to a different topic that you've already created.
f. Select the Slide 3 structure bar and repeat these steps to link the image to the
Images.htm topic, which is located under the D_Images folder in the Content Explorer.
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g. Right-click the Slide 4 structure bar, and from the context menu click Remove Slide.
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h. Right-click the main MadCap:slideshow structure bar, and from the context menu select
Edit Slideshow.

The Edit Slideshow dialog opens.
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i. In the Slides section, the first slide row should be selected. In the Caption field, change
the text to Headings (to correspond with the topic you selected as the link).

CHAPTER 3

64

j. Select the second slide row and change the caption to Drop-Downs.

CHAPTER 3

65

k. Select the third slide row and change the caption to Images.

l. Click OK.
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BUTTONS
a. Scroll down in the topic until you see the buttons (i.e., rectangles with text) under the
"Meet FictionSoft Pro" and "PDF Guides" sections.
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NOTE: You probably have noticed that something looks wrong with the bulleted
list. The style controlling the look of the list is pointing to a bullet image that we
did not include in the import. We will direct the style to a different bullet image
when we edit styles in this tutorial. See "Editing Styles" on page 78.
Also, in the image above, the organization of the PDF images looks incorrect.
This is happening due to the current size of the XML Editor. If we maximize Flare,
the editor will show three PDF images on top of the other three, just as it appears
in the output. This entire section that shows the bulleted list, the PDF guides, and
the buttons is made up of responsive layouts. This feature lets you structure content so that it adapts as the size of the screen changes in the output. When we
edit styles in this tutorial, we will briefly adjust one of these responsive layouts in
the master page. See the online Help to learn about responsive layouts.
b. Select the text in the first button ("Where Do I Begin?") and replace it with Headings.
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c. Right-click the text you added, and in the context menu select Edit Hyperlink. The Insert
Hyperlink dialog opens.
d. In the Link to section, select File in Project. Then expand A_Introduction Topics and click
Headings.htm. Then click OK.
e. Select the text in the second button ("Basic Steps") and replace it with Drop-Downs.

f. Right-click the text you added, and in the context menu select Edit Hyperlink. The Insert
Hyperlink dialog opens.
g. In the Link to section, select File in Project. Then expand A_Introduction Topics and click
DropDowns.htm. Then click OK.
h. Let's say you do not want to keep the third button ("View More PDFs"), so let's remove it.
Click on the button text.
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i. Right-click the outer div structure bar that accompanies the button, and from the context
menu select Delete.
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VIDEOS
Like the sections above it, the video section uses a responsive layout. If you do not have
videos, or if you do not want them on your Home topic, you can delete the main div structure
bar to the left of it. In this tutorial, we are going to keep the video section, but we will replace
the link in the first YouTube video, just to show how it is done.
a. Go to YouTube and find any video you want to use in place of the first video on the Home
page. Using the Share option in YouTube, copy the URL address for the video. For
example, the URL for the first video on the Home page is https://youtu.be/WWcJoqGJ1E0.
b. Go back to the Flare project, right-click the first video ("Sample Movie 1") in the Home
topic, and from the context menu select Edit Multimedia.

The Edit Multimedia dialog opens.
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c. On the General tab, highlight the current URL text in the Multimedia from Web field and
paste your URL. A preview of the video displays to the right.
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d. Click OK. The new video replaces the old one in the Home topic.

7. Click
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to save your work.
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REPLACE CONTENT AND LINKS IN THE MASTER PAGE
Complete the following steps in the Legacy project.
1. In the Content Explorer, expand the Resources folder and then the MasterPages subfolder.
There are three master pages in this folder. The file "MasterPage.flmsp" is the one that
already belonged to the old project. We will no longer use this master page. The other two
were part of the import.

2. Double-click HomePage.flmsp. The file opens to the right in the XML Editor. The area with the
dark background is the footer area for the Home page topic.
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3. In an actual conversion, you would probably change most of the content in this master page
with your own information and links (logo, text, variables, links on the text and images). In this
tutorial, we will change just a few things.

LOGO
a. Right-click the gray Missing file bar, and from the context menu select Image Properties.

The Image Properties dialog opens.
b. Find and select a small image that you want to use as a logo.
c. Click OK. The image is added to the master page. In the example below, we selected our
Flare logo.
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TEXT AND HYPERLINKS
a. To the right of the logo, click on the first piece of text—PDFs. Notice the span bars at the
top of the topic. There are four bars with "a" on each, indicating that they are text hyperlinks. Even though the text runs together in the editor, the styles will separate them in the
output.

b. Highlight the PDFs text and replace it with the word Lists.
c. Above the topic, right-click the first "a" span bar, which is associated with your new text.

d. From the context menu, select Edit Hyperlink.
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e. In the Link to section, select File in Project.
Then expand B_Links and Lists and click Lists.htm.

f. Click OK.
g. Redirect the other three text links to any topics in the project, so that you do not experience errors when you build the output. You can also change the text for each link if you
want.
4. Click

to save your work.

NOTE: If you keep the Twitter and/or Facebook images in your real project, make sure you
change the hyperlinks on them to your own pages.

For more information about working in the XML Editor and editing text hyperlinks, see the online
Help.
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Editing Styles
So far we've imported files from the Temp project. We've also replaced some content and links in
the Home page and master page that were imported.
Now we need to make some changes to our stylesheets—both the StylesForHomePage.css file that
was imported, as well as the stylesheet that already existed in our Legacy project.
Complete all of the following steps in the Legacy project.

FIX THE BULLETS ON THE HOME PAGE
As you may recall, the bullet images are missing in the Home topic, because we did not include
them in the import. Instead, we want to use bullet images that already exist in our project.
1. In the Content Explorer, expand the Resources folder, then the Stylesheets subfolder.
2. Double-click StylesForHomePage.css. The stylesheet opens to the right in the Stylesheet
Editor.
3. In the local toolbar, make sure the first button displays

. If the button displays

instead, then click it.

4. On the left side of the Stylesheet Editor, make sure the filter at the top shows All Styles. And
expand (Complex Selectors) below.
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5. Select #content-section.mc-blurb .mc-bullets > li.
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6. In the local toolbar, click
to an alphabetical list.
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. This changes the view of the properties on the right from groups
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7. On the right side of the local toolbar, click the Show drop-down field and select Show: Set Properties. This filters the properties below to only those that have been explicitly set in the
stylesheet for the selected style, as well as any properties explicitly set in an inherited
stylesheet.
As you can see, only a few properties were set on this style. One points to a small image that
serves as the bullet.

8. At the end of the list-style-image field, click

. The Insert Image dialog opens.

NOTE: If you do not want to use an image for a button, you can click the down arrow
in this field and select none.
9. Expand the Resources folder, then Images.
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10. Select Bullet1Online.png.

11. Click OK.
12. Click

to save your work.

13. Go back to the Home topic and notice that the list now has the bullets.
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ADJUST THE SPACING ON THE MASTER PAGE
When we build the output, the footer on the Home page will look like this:

We want to create a little bit more space between the logo and the text links and the copyright. To
do this, we are going to edit the styles being used. But we are not going to do this in the stylesheet,
but rather in the topic itself. The reason for this is that the footer is using a responsive layout, and by
adjusting the settings in the Responsive Layout window pane, we will be automatically changing the
relevant styles.
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1. Open the HomePage.flmsp master page.
2. In the Home ribbon at the top of Flare, go to the Styles section and click Responsive Layout.

The Responsive Layout window pane opens on the right side of the interface.

3. As you have probably noticed, the footer content is contained in three cells. We are going to
widen the first cell a bit, while we reduce the width of the second cell. Click in the first cell containing the logo image.
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4. In the Responsive Layout window pane, click the Cell Width field and select 4. This changes
the width of that cell from 25% to 33.333%; this style change is shown at the bottom of the
window pane. Also, in the XML Editor you will see the third cell (containing the Twitter and
Facebook icons) shift to the bottom, but that will change in the next step.
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5. Click in the second cell containing the text links and copyright. Then in the Responsive Layout
window pane, click the Cell Width field and select 5. This changes the width of that cell from
50% to 41.667%. Also, the third cell in the XML Editor shifts back up to the top (if it doesn’t, try
maximizing the Flare interface).
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6. That takes care of the responsive layout for web (large screens). Now we will make adjusts
for medium-sized screens. At the top of the Responsive Layout window pane, click Tablet.
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The XML Editor changes, showing the master page at the tablet width, which is set on the
Skin tab of the Target Editor. This is why you might see a horizontal scroll bar at the bottom of
the XML Editor.

If you were to reduce the tablet setting in the Target Editor, the XML Editor display would also
be reduced.
7. With the cursor still in the second cell, set the Cell Width in the Responsive Layout window
pane to 5.
8. In the XML Editor, click in the first cell with the logo. In the Responsive Layout window pane,
set the Cell Width in to 4.
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9. At the top of the Responsive Layout window pane, click Web to return to that view in the XML
Editor. You do not need to make adjustments for the Mobile medium, because that configuration of the footer places one cell on top of the other.
Also, you do not need to save your topic in this case, because the changes were actually
made and (auto-saved) to the stylesheet, not to the topic.
When you build the output, the footer will have a little more space between the logo and text
hyperlinks.

For more on responsive layouts, see the online Help.
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POSITION THE SIDE MENU
There is one change that we want to make in our existing stylesheet in the Legacy project in order
to better support the Top Navigation output. We need to add a style class called "div.sideContent,"
which positions the context-sensitive menu in topics to the side of topics, allowing content to flow
under it.
This particular style was included in the MainStyles.css stylesheet from the Temp project. However,
that stylesheet is not one of the files that we imported into our Legacy project, because we didn't
want to use any of its other styles. The good news is that we can quickly import this single style
from that stylesheet into our existing stylesheet.
1. In the Content Explorer, expand the Resources folder, then the Stylesheets subfolder.
2. Double-click styles.css (the stylesheet that already existed in our Legacy project). It opens to
the right in the Stylesheet Editor.
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3. In the local toolbar, click the Options drop-down and select Import Styles.

The Import Styles dialog opens.
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4. At the end of the File field, click Browse.
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5. In the dialog that opens, navigate to the Temp project that we imported from at the beginning
of this tutorial. Once you find it, navigate to Content > Resources > Stylesheets. You should
see its two stylesheets.

6. Select MainStyles and click Open. The styles from that stylesheet are listed in the Import
Styles dialog.
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7. In the list of styles at the bottom, scroll down until you find div.sideContent and click the
check box next to it.

8. Click OK. The style class is added to your stylesheet.
9. Click

to save your work.

For more information about styles and editing them, see the online Help.
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Incorporating the Skin
We already imported the Top Navigation skin from the Temp project, so we don't need to add one.
We just need to edit the skin and select it in our HTML5 target.

EDIT THE SKIN
You can edit a skin to change many aspects of it. In this tutorial, we are just going to change the
logo, but you can change much more when you customize your own skin.
Complete the following in the Legacy project.
1. In the Project Organizer, expand the Skins folder.
2. Double-click HTML5 - Top Navigation, the skin that we imported from the Temp project. It
opens to the right in the HTML5 Skin Editor.
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On the Setup tab you will see several fields. One of these is called “Main Menu Position.” This
is the field that allows you to specify Top Navigation output, as opposed to Side Navigation output. You can select Left or Right (which are Side Navigation options) or Top (which is the Top
Navigation option). In this example, the field is set to “Top,” which means the main navigation
menu—which is driven by your table of contents—will appear at the top of the user’s screen
when viewed on a large monitor.

3. Select the Styles tab.
4. Under the Header section, expand Logo, then Background.
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5. At the end of the Image field, click

.

The Insert Image dialog opens.
6. Click

.

7. In the dialog that opens, find and select the small image you want to use as a logo (the same
image you inserted into the master page). When finished, click Open.
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8. In the Insert Image dialog, click OK.
The logo appears in the preview of the HTML5 Skin Editor. In the example below, we inserted
the Flare logo.

9. Click
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to save your work.
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SELECT THE SKIN IN THE TARGET
1. In the Project Organizer, expand the Targets folder, then the Online Output subfolder.
2. Double-click the HTML5 target. The Target Editor opens to the right. In the following example,
we've renamed the target to "HTML5 TopNav" so that it no longer mentions Tripane.

3. Select the Skin tab.
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4. Click in the Skin field and select HTML5 - Top Navigation.

5. Click

to save your work.

For more information about skins, see the online Help.
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Choosing the Startup Topic
Our new Home topic looks the way we want, but we need to make sure it is the first topic that displays when someone opens the output.

CHOOSE THE STARTUP TOPIC
Complete the following in the Legacy project.
1. The HTML5 target should still be open. If it isn't, double-click it in the Project Organizer.
2. Select the General tab.
3. Next to the Startup Topic field, click

. The Link to Topic dialog opens.

4. Select Home.htm and click Open. The topic is now associated with the target.

5. Click

to save your work.

NOTE: In the Skin Editor, the default setting is to link the startup topic to the logo that displays in the header. So anytime users want to return to the Home topic, they just click the
logo.
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Selecting the Master Page
We imported two master pages from the Temp project—one to be used for the Home page and the
other to be used with the rest of the topics. The good news is that we don't need to do anything else
with the master page for the Home topic, because the two files are already linked. The only thing we
need to do is associate the other master page with the rest of the topics.

SELECT THE MASTER PAGE
Complete the following in the Legacy project.
1. The HTML5 target should still be open. If it isn't, double-click it in the Project Organizer.
2. Select the Advanced tab.
3. Scroll down, and in the Master Page field, select Resources > MasterPages > OtherTopics.

4. Click

to save your work.

For more information about master pages, see the online Help.
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Building and Viewing Output
Now let's build the output and see how it looks.

BUILD AND VIEW OUTPUT
1. In the Project Organizer, double-click the HTML5 target to open it.
2. In the local toolbar of the Target Editor, click

.

The Builds window pane opens at the bottom of the Flare interface, and the target begins to
generate.
When the build finishes successfully, the Build Progress and Compile Progress cells turn dark
green.
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3. Double-click the row to open the output in your browser. It should look like this:
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If you open one of the topics other than the Home page, you will see the side context-sensitive
menu.

NOTE: You also might have noticed that the project we converted has "See Also" links
at the bottom of topics. Because we added a context-sensitive menu, you might find
these concept links to be unnecessary in your own converted project. If so, you can
delete those links from your topics.

For more information about building output, see the online Help.
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CHAPTER 4

Cross-References
When it comes to creating internal links in a project (e.g., links from one topic to another), cross-references are preferred over hyperlinks. That's because they're smarter and require much less maintenance. Hyperlinks are best for external links (e.g., to a website or PDF). You can see a sample
cross-reference by opening the Links topic in the template.
In the Top Navigation Advanced template, we wanted links from one topic to another in the online
output to look like this:
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CREATE A CROSS-REFERENCE FORMAT
1. Do one of the following:

USE THE STYLESHEET EDITOR (BEGINNERS)
a. Open a stylesheet and select the following:
n

At the top of the Stylesheet Editor, click in the Medium drop-down and select
default (if it is not already open).

n

In the local toolbar, make sure the first button displays
ton displays

n

. If the but-

instead, then click it.

In the upper-left corner of the editor, click in the drop-down field and select
.

n

Make sure Hide Inherited is not selected.

n

On the left side of the Stylesheet Editor, select the MadCap|xref style.

n

From the Show drop-down list on the upper-right side of the editor, select
.

n

In the local toolbar, click

(if the properties are shown in grouped view). The but-

ton changes to
, and the view of the properties on the right changes from
groups to an alphabetical list.
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NOTE: The Top Navigation Advanced template has two stylesheets. We modified the styles primarily in the one called "MainStyles.css," which is used for most
of the topics. If you plan to use cross-references on the Home page topic, which
uses the other stylesheet, you can make the same changes there as well.
b. On the right side of the Stylesheet Editor, scroll down in the list of properties and set the
following:
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n

color Click
, and in the dialog click in the # field and type 2D8DCC (or choose
another color if you want). Then click OK.

n

font-weight Select bold.

n

mc-format Enter {para}.
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NOTE: There are lots of other formats that we could have created in this
dialog. But we liked {para} because it's simple and does just what we
want—displays the first text it finds in the file we point to, which is usually
the heading.

n

text-decoration Select underline.

c. Now you need to tell Flare what to do when someone hovers over the cross-reference. On
the left side of the Stylesheet Editor, expand the MadCap|xref style. Then under that,
expand (Pseudo Classes) and select hover.

d. On the right side of the Stylesheet Editor, set the following properties:
n

e. Click
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color Click
, and in the dialog click in the # field and type BED230 (or choose
another color if you want). Then click OK.
to save your work.
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GET THE CSS (ADVANCED USERS)
Enter this in the default medium in the stylesheet:
MadCap|xref
{
color: #2D8DCC;
font-weight: bold;
mc-format: '{para}';
text-decoration: underline;
}
MadCap|xref:hover
{
color: #BED230;
}

NOTE: There are lots of other formats that we could have created in this dialog. But
we liked {para} because it's simple and does just what we want—displays the first text
it finds in the file we point to, which is usually the heading.

NOTE: The Top Navigation Advanced template has two stylesheets. We modified the
styles primarily in the one called "MainStyles.css," which is used for most of the topics. If you plan to use cross-references on the Home page topic, which uses the other
stylesheet, you can make the same changes there as well.
2. Whenever you insert a cross-reference, select the MadCap:xref style.
NOTE: You can also create classes of the MadCap:xref style. We just happened to
use the parent MadCap:xref style in this template.

For more information about cross-references and editing them, see the online Help.
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CHAPTER 5

Drop-Downs
Creating drop-downs is quite easy in Flare. It's just a matter of selecting the content that you want
to be in the drop-down (both the header and the content below) and clicking a button. In this template, we used styles to make some adjustments to the look of drop-downs. You can see the dropdowns by opening the FAQs topic in the template.
This chapter discusses the following:
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First-Level Drop-Downs

114

Second-Level Drop-Downs

122

Applying Drop-Down Styles

125
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Style Properties
Here are some of the main properties that we adjusted for our styles:
n

Border We added borders to the bottom of drop-downs to make it easier for the reader to distinguish one drop-down from another when there are many of them in row. We also created a
style class that displays the final drop-down in a series without a bottom border.
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n

Icons We associated custom icons with the drop-downs to distinguish first-level drop-downs
from second-level drop-downs. Furthermore, we used multiple icons to display the dropdowns when they are expanded and collapsed.

n

Hover Color We styled the drop-down hotspot so that it shows a different color when users
hover over it.
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First-Level Drop-Downs
We used the parent drop-down style for first-level drop-downs.
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1. Do one of the following:

USE THE STYLESHEET EDITOR (BEGINNERS)
a. Open a stylesheet and select the following:
n

At the top of the Stylesheet Editor, click in the Medium drop-down and select
default (if it is not already open).

n

In the local toolbar, make sure the first button displays
ton displays

n

. If the but-

instead, then click it.

In the upper-left corner of the editor, click in the drop-down field and select
.

n

Make sure Hide Inherited is not selected.

n

On the left side of the Stylesheet Editor, select the MadCap|dropDown style.

n

From the Show drop-down list on the upper-right side of the editor, select
.

n

In the local toolbar, click

(if the properties are shown in grouped view). The but-

ton changes to
, and the view of the properties on the right changes from
groups to an alphabetical list.
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b. On the right side of the Stylesheet Editor, set the following:
n

margin-bottom Set it to 6px.

n

margin-top Set it to 6px.

n

mc-closed-image Click
. The Insert Image dialog opens. Find and select an
image you want to use. This is the image that is used when the drop-down is in a
closed (or collapsed) state. In our template, we selected an image called
"DropDownClosed" that we stored in the Resources/Images subfolder of the Content Explorer.

n

mc-open-image Click
. The Insert Image dialog opens. Find and select an image
you want to use. This is the image that is used when the drop-down is in an open (or
expanded) state. In our template, we selected an image called "DropDownOpen"
that we stored in the Resources/Images subfolder of the Content Explorer.

c. Now you need to give the first-level drop-down a bottom border. On the left side of the
Stylesheet Editor, select the MadCap|dropDownBody style.

CHAPTER 5

116

d. On the right side of the Stylesheet Editor, set the following:
n

border-bottom Set it to 1px #bed230 (you can choose another color besides
#bed230 if you want).

e. Next, let's account for the final drop-downs that we don't want to have borders. On the
left side of the Stylesheet Editor, select the MadCap|dropDownBody style.
f. In the local toolbar, click Add Selector. The New Selector dialog opens.
g. In the Class Name field, type a name for the new style class (we named ours "Final").

h. Click OK.
i. With that new style class selected, on the right side of the Stylesheet Editor, set the following:
n
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border-bottom Set it to 0.
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j. And finally, you need to give a unique look to the drop-down link, including a different color
when users hover over it. On the left side of the Stylesheet Editor, select the
MadCap|dropDownHotspot style.

k. On the right side of the Stylesheet Editor, set the following properties:

CHAPTER 5

n

color Click
, and in the dialog click in the # field and type 404040 (or choose
another color if you want). Then click OK.

n

font-size Set it to 0.9em.

n

font-weight Select bold.
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l. Now expand the MadCap|dropDownHotspot style. Then expand (Pseudo Classes) under
that, and select hover.

m. On the right side of the Stylesheet Editor, set the following:
n
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color Click
, and in the dialog click in the # field and type BED230 (or choose
another color if you want). Then click OK.
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GET THE CSS (ADVANCED USERS)
Enter this in the default medium in the stylesheet (replacing the example images with your
own):
MadCap|dropDown
{
margin-bottom: 6px;
margin-top: 6px;
mc-closed-image: url('../Images/DropDownClosed.png');
mc-open-image: url('../Images/DropDownOpen.png');
}
MadCap|dropDownBody
{
border-bottom: solid 1px#bed230;
}
MadCap|dropDownBody.Final
{
border-bottom: 0;
}
MadCap|dropDownHotspot
{
color: #404040;
font-size: 0.9em;
font-weight: bold;
}
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MadCap|dropDownHotspot:hover
{
color: #bed230;
}
2. Click

to save your work.

Now that you've got your styles, you just need to apply them to the correct parts of the dropdown.

CHAPTER 5

121

Second-Level Drop-Downs
We created a style class to make second-level drop-downs indented.
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1. Do one of the following:

USE THE STYLESHEET EDITOR (BEGINNERS)
a. On the left side of the Stylesheet Editor, select the MadCap|dropDown style.
b. In the local toolbar, click Add Selector. The New Selector dialog opens.
c. In the Class Name field, type a name for the new style class (we named ours "SecondLevel").

d. Click OK.
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e. On the right side of the Stylesheet Editor, set the following:
n

margin-left Set it to 10px.

n

mc-closed-image Click
. The Insert Image dialog opens. Find and select an
image you want to use. This is the image that is used when the drop-down is in a
closed (or collapsed) state. In our template, we selected an image called
"DropDownClosedSecondLevel" that we stored in the Resources/Images subfolder
of the Content Explorer.

n

mc-open-image Click
. The Insert Image dialog opens. Find and select an image
you want to use. This is the image that is used when the drop-down is in an open (or
expanded) state. In our template, we selected an image called "DropDownOpenSecondLevel" that we stored in the Resources/Images subfolder of the Content
Explorer.

You don't need to set anymore styles for the second-level, because the second level will
inherit all of the other settings from the parent (first-level) styles.

GET THE CSS (ADVANCED USERS)
Enter this in the default medium in the stylesheet (replacing the example images with your
own):
MadCap|dropDown.SecondLevel
{
margin-left: 10px;
mc-closed-image: url('../Images/DropDownClosedSecondLevel.png');
mc-open-image: url('../Images/DropDownOpenSecondLevel.png');
}
2. Click

to save your work.

Now that you've got your styles, you just need to apply them to the correct parts of the dropdown.
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Applying Drop-Down Styles
1. Insert a drop-down effect:
a. Open the content file (e.g., topic, snippet).
b. In the XML Editor type and format the content that will become the drop-down hotspot
and the drop-down body.
c. Highlight all of the paragraphs that you want to be part of the drop-down effect, including
the first paragraph, which will contain the hotspot.
d. Select the Insert ribbon. In the Text section, select Drop-Down Text.
The selected content is converted to a drop-down effect, and it now has brackets around
it in the XML Editor (if markers are turned on). The hotspot has a blue down arrow to the
left of it.
2. If the tag block bars are not shown to the left of the content, click
editor.

at the bottom of the

3. Do the following to apply the appropriate styles to the different parts of a drop-down.

TO MAKE A SECOND-LEVEL DROP-DOWN
a. On the Home ribbon, click Style Window.

The Styles window pane opens on the right side of the interface.
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b. In the topic, click the MadCap:dropDown structure bar to the left of the drop-down effect
you created.
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c. In the Styles window pane, select the class you created for the second level. In this template, our class is named "MadCap:dropDown.SecondLevel."
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TO REMOVE THE BOTTOM BORDER
In this template, you don't need to add the bottom border, because we've designed the styles
so that they will all initially have a bottom border when first inserted. Use the following steps
to remove the bottom border for the final drop-down in a sequence (e.g., the final first-level
drop-down or the final second-level drop-down in a row).
a. Right-click the MadCap:dropDownBody structure bar to the left of the drop-down effect.
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b. In the content menu, select Style Class. Then select the class you created to remove the
bottom border. In this template, our class is named "MadCap:dropDownBody.Final."
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The border is removed from the bottom of the drop-down.

4. Click

to save your work.

For more information about drop-downs and editing them, see the online Help.
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CHAPTER 6

Image Sizing and Positioning
There are multiple topics in this template that contain images. Sizing is always a major concern with
images, because you want them not only to be the right size, but also to look as good as possible. In
addition, some images in this template were positioned in such a way to let text flow to the right or
left of it.
In this template, we controlled the quality, size, and position of the images.
This chapter discusses the following:
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Purpose of Images
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Max Height/Width and Thumbnails

133

Positioning with Floats and Div Styles

139
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Purpose of Images
If you look at the files in the Resources/Images subfolder in the Content Explorer, you'll see several
PNG image files.

These images have been used in the template for a variety of purposes. Some are used as regular
images inserted into topics. Some are used in place of bullets in lists (see "Lists" on page 144).
Some are used for special effects, such as drop-downs (see "Drop-Downs" on page 111). And so on…
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Max Height/Width and Thumbnails
We wanted to control the height of some pictures, such as the check mark and red X images that
you see in tables.
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In addition, we wanted some of the larger images to be shown as thumbnail images that enlarge
when clicked.
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To accomplish this, we created some image style classes and placed settings on them to control
the size or turn them into thumbnails.
1. Do one of the following:

USE THE STYLESHEET EDITOR (BEGINNERS)
a. Open a stylesheet and select the following:
n

At the top of the Stylesheet Editor, click in the Medium drop-down and select
default (if it is not already open).

n

In the local toolbar, make sure the first button displays
ton displays

n

. If the but-

instead, then click it.

In the upper-left corner of the editor, click in the drop-down field and select
.

n

Make sure Hide Inherited is not selected.

n

On the left side of the Stylesheet Editor, select the img style.

n

From the Show drop-down list on the upper-right side of the editor, select
.

n

In the local toolbar, click

(if the properties are shown in grouped view). The but-

ton changes to
, and the view of the properties on the right changes from
groups to an alphabetical list.
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NOTE: The Top Navigation Advanced template has two stylesheets. We modified the styles primarily in the one called "MainStyles.css," which is used for most
of the topics. If you plan to use images in the same way on the Home page topic,
which uses the other stylesheet, you can make the same changes there as well.
b. In the local toolbar, click Add Selector. The New Selector dialog opens.
c. In the Class Name field, type a name for each new style class and click OK. In this template, we named our image style classes as follows:
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n

ReduceButtonSize This style class is used on small "button-size" images that we
want to be shrunk (when necessary) to no more than 25 pixels high.

n

Thumbnail This style class is used on larger images that we want to display as a
thumbnail in the output.

136

The two style classes are added in the stylesheet under the parent img style.

d. Select the ReduceButtonSize class, and on the right side of the Stylesheet Editor, set the
following:
n

max-height Set it to 25px.

e. Select the Thumbnail class, and on the right side of the Stylesheet Editor, set the following:
n

mc-thumbnail Set it to popup.

GET THE CSS (ADVANCED USERS)
Enter this in the default medium in the stylesheet:
img.ReduceButtonSize
{
max-height: 25px;
}
img.Thumbnail
{
mc-thumbnail: popup;
}
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NOTE: The Top Navigation Advanced template has two stylesheets. We modified the
styles primarily in the one called "MainStyles.css," which is used for most of the topics. If you plan to use images in the same way on the Home page topic, which uses
the other stylesheet, you can make the same changes there as well.

2. Click

to save your work.

3. Now that you've got your styles, you just need to apply them to the appropriate images. For
example, let's say you have already inserted a large image into a topic and want it to show as
a thumbnail in the output. In that case, you can right-click the image and from the context
menu select Style Class > img.Thumbnail.
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Positioning with Floats and Div Styles
To position some images (and their figure captions in print output), we created div style classes and
placed float settings on them. A <div> tag essentially acts as a container, allowing us to place other
tags within it.

TIP: Placing images in <div> tags can be especially useful if you want to include other content in the container as well. For example, if you decide to also create print-based output
from the project, you can add text that serves as a figure caption, with autonumbering
applied to it. Because the figure caption is in the <div> tag with the image, it travels with the
image wherever it is positioned.
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1. Do one of the following:

USE THE STYLESHEET EDITOR (BEGINNERS)
a. Open a stylesheet and select the following:
n

At the top of the Stylesheet Editor, click in the Medium drop-down and select
default (if it is not already open).

n

In the local toolbar, make sure the first button displays
ton displays

n

. If the but-

instead, then click it.

In the upper-left corner of the Stylesheet Editor, click in the drop-down field and
select

.

n

Make sure Hide Inherited is not selected.

n

On the left side of the Stylesheet Editor, select the div style.

n

From the Show drop-down list on the upper-right side of the editor, select
.

n

In the local toolbar, click

(if the properties are shown in grouped view). The but-

ton changes to
, and the view of the properties on the right changes from
groups to an alphabetical list.

b. In the local toolbar, click Add Selector.
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c. In the Class Name field, type a name for the new style class and click OK. In this template, we created the following div style classes related to images:
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n

ImagesFloatLeft This style class is used on images that we want to be positioned
to the left of the main body text.

n

ImagesFloatRight This style class is used on images that we want to be positioned
to the right of the main body text.
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The two style classes are added in the stylesheet under the parent div style.

d. Select the ImageFloatLeft class, and on the right side of the Stylesheet Editor, set the following:
n

clear Set it to both.

n

float Set it to left.

n

margin-right Set it to 10px.

n

padding Set it to 5px.

e. Select the ImageFloatRight class, and on the right side of the Stylesheet Editor, set the
following:
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n

clear Set it to both.

n

float Set it to right.

n

margin-left Set it to 10px.

n

padding Set it to 5px.
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GET THE CSS (ADVANCED USERS)
Enter this in the default medium in the stylesheet:
div.ImagesFloatLeft
{
clear: both;
float: left;
margin-right: 10px;
padding: 5px;
}
div.ImagesFloatRight
{
clear: both;
float: right;
margin-left: 10px;
padding: 5px;
}
2. Click

to save your work.

3. Now that you've got your styles, you just need to apply them to the appropriate images. For
example, let's say you've inserted an image that you want to float to the left, so that the main
topic text floats to the right. To accomplish this, do the following:
a. Click in the middle of the inserted image to select it.
b. Press Tab on your keyboard.
c. In the Create Group dialog, select div.ImagesFloatLeft.
d. Click OK.
For more information about images, as well as sizing and positioning them, see the online Help.
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CHAPTER 7

Lists
This template contains a topic named "Lists" that contains many different kinds of lists that you can
use or re-create in your own topics.
This chapter discusses the following:
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CSS Styles

148

Create Lists

155
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Types of Lists
Here are the kinds of lists found in our template:
n

Simple Numbered List

n

Simple Bulleted List

n

Lists With Paragraphs Between Items
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n

Multi-level Numbered List
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n

Multi-level Bulleted List

n

Multi-level List (Mixed)
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CSS Styles
In our template, we modified some styles to give each list a particular look. For bulleted lists, this
included associating the style with a custom bullet image.
1. Do one of the following:

USE THE STYLESHEET EDITOR (BEGINNERS)
a. Open a stylesheet and select the following:
n

At the top of the Stylesheet Editor, click in the Medium drop-down and select
default (if it is not already open).

n

In the local toolbar, make sure the first button displays
ton displays

n

. If the but-

instead, then click it.

In the upper-left of the editor, make sure the drop-down field is set to
.

n

Make sure Hide Inherited is not selected.

n

On the left side of the Stylesheet Editor, select the ol style.

n

From the Show drop-down list on the upper-right side of the editor, select
.

n

In the local toolbar, click

(if the properties are shown in grouped view). The but-

ton changes to
, and the view of the properties on the right changes from
groups to an alphabetical list.
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NOTE: The Top Navigation Advanced template has two stylesheets. We modified the styles primarily in the one called "MainStyles.css," which is used for most
of the topics. If you plan to use lists in the same way on the Home page topic,
which uses the other stylesheet, you can make the same changes there as well.
b. On the right side of the Stylesheet Editor, set the following:
n

list-style-image Select none. This prevents an numbered item from showing as a
bullet in a mixed list (i.e., one with both numbers and bullets).

c. Scroll down on the left side of the editor and select the ul style. Then on the right side of
the Stylesheet Editor, set the following:
n
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list-style-image Click
. The Insert Image dialog opens. Find and select an image
you want to use. This is the image that is used for first-level bulleted list items. In
our template, we selected an image called "Bullet1.png" that we stored in the
Resources/Images subfolder of the Content Explorer.
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d. That takes care of our basic ordered (ol) and unordered (ul) lists. But we also want to tell
Flare what to do if there is a numbered or bulleted list at the second or even third level in
a multi-level list. On the left side of the editor, scroll all the way to the top and expand
(Complex Selectors). Then choose the ol ol selector.

This particular selector has to do with numbered lists at the second level. As soon as you
create a numbered list at the second level, the properties for this selector will automatically be applied to it. The same is true with ul ul, which has to do with bulleted lists at
the second level.
e. On the right side of the Stylesheet Editor, set the following:
n

list-style-type Select lower-alpha.

f. With the ol ol selector still highlighted on the left side of the editor, go to the local toolbar
and click Add Selector. The New Selector dialog opens.
g. Click Advanced Options to expand it.
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h. In the Advanced Selector field, place your cursor after the second ol, type a space, then
type a third ol.
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i. Click OK. That new selector is added in the stylesheet under ol ol.

j. With the ol ol ol selector highlighted, go to the right side of the Stylesheet Editor and set
the following:
n

list-style-type Select lower-roman.

k. Select the ul ul selector, and on the right side of the Stylesheet Editor, set the following:
n

list-style-image Click
. The Insert Image dialog opens. Find and select an image
you want to use. This is the image that is used for second-level bulleted list items.
In our template, we selected an image called "Bullet2.png" that we stored in the
Resources/Images subfolder of the Content Explorer.
We could also create a complex selector called "ul ul ul" for third-level items in a bulleted list, but we won't do that in this tutorial.
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GET THE CSS (ADVANCED USERS)
Enter the following in the default medium in the stylesheet. (The referenced images are ones
we have already added to the Resources folder in the Content Explorer. You can replace
these with your own images.)
ol
{
list-style-image: none;
}
ol ol
{
list-style-type: lower-alpha;
}
ol ol ol
{
list-style-type: lower-roman;
}
ul
{
list-style-image: url('../Images/Bullet1.png');
}
ul ul
{
list-style-image: url('../Images/Bullet2.png');
}
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NOTE: The Top Navigation Advanced template has two stylesheets. We modified the
styles primarily in the one called "MainStyles.css," which is used for most of the topics. If you plan to use lists in the same way on the Home page topic, which uses the
other stylesheet, you can make the same changes there as well.

NOTE: For the ol style, we set the list-style-image to "none" because it helps to prevent numbers from being shown mistakenly as bullets in mixed lists.

2. Click
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to save your work.
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Create Lists
Now that the styles are modified, we can create our lists. We do not need to apply styles manually,
because the styles are based on the list levels, so they are applied automatically.
1. Place your cursor in the document where you want to insert a list. Then do the following,
depending on the type of list:

SIMPLE NUMBERED LIST
a. Select the Home ribbon. In the Paragraph section click the down arrow next to the list button

and select Numbered List.

b. After providing the content for a list item, press Enter. Then enter the next list item text,
and so on. To exist the list format, press Enter again on a blank list item.

SIMPLE BULLETED LIST
a. Select the Home ribbon. In the Paragraph section click the face of the list button
Alternatively, you can select the down arrow next to it and select Bullet List.

.

b. After providing the content for a list item, press Enter. Then enter the next list item text,
and so on. To exit the list format, press Enter again on a blank list item.

LIST WITH PARAGRAPHS BETWEEN ITEMS
a. Follow any of the steps in this topic for creating a particular kind of list.
b. Click in the list where you want to add a paragraph item. For example, if you want to add
a comment between steps 2 and 3, place your cursor at the very end of step 2.
c. Select the Home ribbon. In the Paragraph section click the down arrow next to the List
Actions button

.

d. Select Make Paragraph Item(s). A <p> tag is added after the <li> tag.
e. To add lines without a number or bullet, simply press Enter on your keyboard and type
your content.
f. To continue the numbering or the bullets, click the paragraph item icon
simply starts another <li> tag.
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MULTI-LEVEL NUMBERED LIST
To replicate the same multi-level numbered list that you see in the template, do the following:
a. Select the Home ribbon. In the Paragraph section click the down arrow next to the list button

and select Numbered List.

b. Provide text for the first list item and press Enter. Then enter text for the second list item
and press Enter.
c. Press Tab on your keyboard. It should look something like this now:

d. Provide text for the first list item and press Enter. Then enter text for the second list item
and press Enter.
e. Press Tab on your keyboard. It should look something like this now:

f. Provide text for the first list item and press Enter. Then enter text for the second list item
and press Enter.
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g. In the Home ribbon, click

. It should look something like this now:

h. Click the yellow arrow button. It should look something like this now:

i. In the Home ribbon, click

.

j. Click the yellow arrow button.
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k. Provide text for the final list item. It should look something like this now:

MULTI-LEVEL BULLETED LIST
To replicate the same multi-level bulleted list that you see in the template, do the following:
a. Select the Home ribbon. In the Paragraph section click the face of the list button
Alternatively, you can select the down arrow next to it and select Bullet List.

.

b. Provide text for the first list item and press Enter.
c. Repeat the first two steps two more times so that you have three bullet items and a blank
bullet item at the end.
NOTE: In our template, we also selected some text at the beginning of each list
item and applied a span style class to display the text in a green font matching
the bullet image.
d. Press Tab on your keyboard. It should look something like this now:
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e. Provide text for the first list item and press Enter. Then enter text for the second list item
and press Enter.
f. In the Home ribbon, click

. It should look something like this now:

g. Click the yellow arrow button. It should look something like this now:
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h. Repeat the steps above to add two more first-level items, followed by two more secondlevel items, and finally two more first-level items. It should look something like this now:

i. Repeat the previous two steps for the other second-level list. When you are finished, it
should look something like this:
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MULTI-LEVEL LIST (MIXED)
To replicate the same multi-level list (mixed) that you see in the template, do the following:
a. Select the Home ribbon. In the Paragraph section click the down arrow next to the list button

and select Numbered List.

b. Provide text for the list item and press Enter.
c. Press Tab on your keyboard. It should look something like this now:

d. Provide text for the list item and press Enter. Then enter text for the next list item and
press Enter.
e. In the Home ribbon, click

. It should look something like this now:

f. Click the yellow arrow button. It should look something like this now:

g. Provide text for the list item and press Enter.
h. Press Tab on your keyboard.
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i. Provide text for the list item and press Enter. Then enter text for the next list item and
press Enter.
j. Press Tab on your keyboard. It should look something like this now:

k. Provide text for the list item and press Enter. Then enter text for the next list item and
press Enter.
l. In the Home ribbon, click

.

m. Click the yellow arrow button.
n. Provide text for the list item and press Enter.
o. In the Home ribbon, click

.

p. Click the yellow arrow button.
q. Provide text for the final list item. It should look something like this now:
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r. Make sure the structure bars are turned on. Right-click the ol structure bar that represents the third-level list.

s. From the context menu, select Type > Bullet List.
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The list should look something like this:

2. Click

to save your work.

For more information about lists, see the online Help.

CHAPTER 7

164

APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
Tripane and PDF Tutorial
USER GUIDES

Accessibility Guide

Getting Started Guide

Analysis and Reports Guide

Global Project Linking Guide

Architecture Guide

HTML Help Guide

Autonumbers Guide

HTML5 Guide

Condition Tags Guide

Images Guide

Context-sensitive Help Guide

Importing Guide

DotNet Help Guide

Index Guide

Eclipse Help Guide

Key Features Guide
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Language Support Guide

Source Control Guide: Git

MadCap Central Integration Guide

Source Control Guide: Perforce

Movies Guide

Source Control Guide: Subversion

Navigation Links Guide

Source Control Guide: Team Foundation Server

Plug-In API Guide

Styles Guide

Print-based Output Guide

Tables Guide

Project Creation Guide

Tables of Contents Guide

Pulse Guide

Targets Guide

QR Codes Guide

Templates Guide

Reports Guide

Topics Guide

Reviews & Contributions Guide

Touring the Workspace Guide

Search Guide

Transition From FrameMaker Guide

SharePoint Guide

Variables Guide

Skins Guide

WebHelp Outputs Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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